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This RTB informs the changes made to the G4 (SiG4) unit software and corrections to the
Schmidt3 ISDN Unit service manual.

1. CHANGES MADE TO THE DEFAULT SETTINGS
The following changes have been made from the first production of August.

Bit Switch 13: D channel layer 3 (Attachment IE in S: SETUP)

FUNCTION COMMENTS

7

Condition for fallback from G4 to
G3
0: Refer to the CPS code setting
1: Fallback in response to any
  CPS code

0: Fallback occurs when a CPS code is the
same as the CPS code settings specified by
G4 internal switches 17, 18, 1A, 1B, and 1C.
If you wish to enable fallback when any CPS
code is detected, set this bit to “1.”

This switch is effective in coping with fallback
problems where the CPS code does not match
those specified in the ITU-T recommendation.

The new default setting is “1.”

Communication Switch 07

No FUNCTION COMMENTS

3

Fallback from G4 to G3 reflected
in programmed Quick/Speed dials
0: Fallback enabled (Default)
1: Always start with G4

0: If a communication falls back from G4 to
G3, the machine will always start transmission
with G3 from the next communication.
1: The machine will always start to transmit
with G4.

The new default setting is “1.”

The default settings have been changed to cope with fallback problems where CPS codes
do not match those specified in the ITU-T recommendations. If you are installing machines
that were manufactured earlier than August, it is recommended to change the settings as
explained above to avoid communication problems.

NOTE:
PCB part numbers: H5476170G (Europe/Asia models), H5476180F (USA model)
Please also refer to MB No. MH547001 for part number information.
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2. NEW SWITCH ADDED TO THE G4 UNIT
The following changes have been made from the first production of August.

G4 Internal Bit Switch 13

No FUNCTION COMMENTS

1

Information transfer capability
shift down to retry transmission
0: Shiftdown procedure disabled
    (Default)
1: Shiftdown and retry the call

1: The machine changes the ISDN G3
information transfer capability informed in the
[SETUP] signal to “Speech” from “3.1 kHz
audio” or to “3.1 kHz audio” from “Speech”
automatically and retries the transmission.

The information transfer capability used in the
first try is determined by the setting of G4
internal bit switch 14 bit 0.

This switch is effective with some types of
exchangers and T/As where they only accept
calls with information transfer capability
“Speech.”

- Cross reference -

G4 Internal Bit Switch 14

No FUNCTION COMMENTS

0

ISDN G3 information transfer
capability
0: 3.1 kHz audio
1: Speech

In tx mode, this determines the information
transfer capability informed in the [SETUP]
message.
In rx mode, this determines the information
transfer capability that the machine can use to
receive a call.
Set this bit to 1 if the ISDN does not support
3.1 kHz audio.

NOTE:
PCB part numbers: H5476170G (Europe/Asia models), H5476180F (USA model)
Please also refer to MB No. MH547001 for part number information.
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3. CORRECTION TO THE SCHMIDT 3 ISDN UNIT SERVICE MANUAL

Wrong Information (page 3-14)

Dedicated Transmssion Parameter Switch 10

No FUNCTION COMMENTS

2

ISDN G3 information transfer
capability for transmission
0: 3.1 kHz audio
1: Speech

This determines the information transfer
capability informed in the [SETUP] message.
Set this bit to 1 if the ISDN does not support
3.1 kHz audio.

Correct Information

Dedicated Transmssion Parameter Switch 10

No FUNCTION COMMENTS

2

3

ISDN G3 information transfer
capability for transmission
Bit 3  2    Setting
     0  0    Speech
     0  1    3.1 kHz audio
     1  0    Not used
     1  1    Same as the G4 internal
               switch 14 bit 0 setting.

This determines the information transfer
capability informed in the [SETUP] message.
Set this bit to 1 if the ISDN does not support
3.1 kHz audio.
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SYMPTOM

RDS displays groups 8, 9, 24 and 25 for Quick Dial 01 after the dial data is read from the
Schmidt 3.  However, groups 8, 9, 24 and 25 are actually not programmed in Quick Dial
01, as the Schmidt 3 can only hold a maximum of seven groups.

SOLUTION

Change the software.

Temporary firmware will be issued (version 045).

Check Sum values

Total : 1F14

Boot : 5123

Main : CDF1

Files

For Flash Card:

File name H547W045.BIN

For RDS:

File name H547W045.FRH/H547W045.LZ
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Symptoms
- The operation panel and keys become inoperative and/or the line becomes

disconnected during reception or transmission.
- “E” or “D” is printed on the TCR as the reception/transmission result.
It should be noted that the above symptom does not always occur.

Cause
When power is supplied to the DRAM, values are assigned to each DRAM address. Of
course, the addresses are formatted before being used. However, we do not know
what values are assigned to unformatted addresses, because the machine does not
control the values before formatting.
According to the test results from our Design Division, the above communication problem can
result if one of three specific addresses attain a value of 60 when the power is turned
on, or when the machine recovers from Energy Saver Mode.
We have also found that this symptom occurs in a very few DRAMs used in Schmidt3
MIFs. Most of the DRAMs which can exhibit the problem have been installed in
production runs from August 1999.

Action taken
Replace the ROM with H5477200H or a later version.
The above problem does not occur on the machines with the new ROM version.

Note
- The new ROM version has been used in production runs from November 1999.
- The machine serial numbers are: 4992xxxxx. The second digit represents the year

(’99) while the third and fourth digits indicate the month. The month can be calculated
by subtracting 84. Therefore, in this case, 92-84=8, or August.

RC REBV ASIA

* * *
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When a level 1 RAM reset is done, the programmed country code goes back to UK. (See
page 4-15 of the service manual.)
So, please set the proper country code after a level 1 RAM reset.

RC REBV ASIA

* * *
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Re: Using RDS with the Schmidt3.
The following have been corrected with the release of firmware version H5477200H.

1) When the firmware H5477200G or an older version is upgraded by RDS, RAM reset is
performed automatically. This will cause the user data to be lost (quick dials, RTI, TTI,
etc.).

2) When group dial data is downloaded from a FAX2900L by RDS and sent to a machine
with more than 7 groups, some data ends up being registered in groups 8 to 10.
This occurs when the firmware is H5477200G or an older version.

There is no risk of losing data if an IC card is used instead of RDS.

RC REBV ASIA

* * *
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Symptom
The noise level of the machine is within standard parameters. However, some customers do not
like the noise generated by the fan, as the machine is sometimes installed on or by a desk.

Action taken
We have prepared the following countermeasure to reduce the noise from the fan:

1) New ROM H5457200J (See MB no. MH545008.) --- Only for Schmidt 1.
    This reduces the noise level of the fan by about 20% during printing.

    Notes
· The running time of the fan is longer than the original time using the old ROM.

· We cannot change the fan control in Schmidt 3.
2) Silencer
   We will provide a special part called a “Silencer” which can be set at the air exit near the fan by

the customer. (See below)
  This will reduce the noise from the fan.
  The part number of the Silencer is H5459500.  This part will be available soon at SPC.

RC REBV ASIA

* * *
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RTB Update

FAX2900L firmware modification history

H5477200K
PCB-FCU: H5476101P, H5476111Q
Schedule: April production run in 2000

Reasons for the change:
1) Bug Correction
- Programmed modes, such as GROUND/FLASH, by User Parameter SW13 are not printed

correctly on the user parameter list when the country code for Hungary is selected.
- Dial data transmission by the RDS is not done properly for the i-Schmidt3.

H5477200J
PCB-FCU: H5476101M, H5476111N
Schedule: Feb. production run in 2000
Reasons for the change:
1) Country code (22H = 034) for Hungary has been added.

H5477200H
PCB-FCU: H5476101L, H5476111M
Schedule: December 1999 production runs.
Reasons for the change:
1) Change of default settings for Bit switches

Communication switch 02 Bit 0: 1 ! 0
G4 switch 13 Bit 1: 0 ! 1  (For Europe)
Redialing with IG3 (SPEECH) when dialing with IG3 (3.1KHz) is unsuccessful.
However, this will be effective in combination with SiG4 ROM version 14.

2) Correction of software bugs:
- User data in S-RAM was cleared after downloading the firmware by RDS.
- When group dial data is downloaded from a FAX2900L by RDS and sent to a machine with more

than 7 groups, some data ends up being registered in groups 8 to 10.
There is no problem when downloading from FAX2900L to FAX2900L.

         -  An alarm display and sound have been added at the calling side in case the user picks up the
handset and hangs up right away when the FAX2900L calls.

NOTE: When the firmware is older than �H� and it is changed by RDS, the RAM data is cleared.

H5477200G
PCB-FCU: H5476101K, H5476111L
Schedule: November 1999 production runs.
Reasons for the change:

       1) Correction of software bugs:
     - On Hook Mode was not turned off in some cases after pressing the On Hook button again.
     - Reception problem (RTB no. RH547003a).
      - Dial data transmission problem on RDS.
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H5477200F
PCB-FCU: H5476101J, H5476111K
Schedule: August 1999 production runs.
Reasons for the change:
1) Correction of software bug:

     - RAM Test (Function 12) did not work for 64 kilobytes of the 128kb SRAM.

H5477200E
PCB-FCU: H5476101G, H5476111H
Schedule: July 1999 production runs.
Reasons for the change:
1) Correction of software bugs:

     - There was a case where a frame was not received during V21 reception.
     - There was a case where re-dial was not done after T1 time expired.
     - �EK� was printed on the transmission report when an error occurred in Broadcasting Mode.
     - There was a case where the Receiver ID was not mentioned in the G4 protocol dump list.
     - The TID received (G4) in small character code was not printed out correctly.
        It was printed out as a space or a special European character.

2) Optimizing machine performance.
     - Detection level for busy tone and re-order tone (US version).
     - Change in the fan control.
     - Selection switch to change the fan controls was added.

The fan was also changed.
The noise caused by the fan can only be improved when the fan is replaced.
This will not affect machine performance in any way.

     - Total scanning time.
       The time that the machine pauses while scanning the original has been reduced.
     - The signal output level has been adjusted to conform with Australian and New Zealand

 regulations.

H5477200D
PCB-FCU: H5476101F, H5476111G
Schedule: June 1999 production runs
Reasons for the change:
1) Software bug correction:

     - No service call.
2) Specification changes

     - Communication switch 07 bit 3: 0 ! 1
     - G4 switch 13 bit 7: 0 ! 1.

H5477200C
      Applied from the 1

st
 lot of mass production of machines for Europe.

Reference:
Procedure for downloading to the IC card:

1) Download the above file to the PC with the Swap File Utility.

2) Insert the IC card into the IC card slot.

3) Run the Swap File Utility.

4) Select "Open" from the File pull-down menu and then select the file.

5) Select "Write" from the Image pull-down menu and input the following items:

          Start Address: 200000.

          Length: Do not change.

          Check: Card erase before write

          Select: Hex.

6) Click "OK".

7) Print out the System Parameter List and confirm that the new ROM version is listed on the sheet.
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This RTB is to inform of mistakes in the service manual.

1. Restricted access

2. System switch 02 bits 6, 7: Memory read/write by RDS

Please refer to the following descriptions for details.

1. Restricted Access

Restricted access is not available in this machine.

Section in the service manual:
1.2 Features
Communication Features - User Selectable: Restricted access

Wrong description

Communication Features - User Selectable

Restricted access O

Correct description

Communication Features - User Selectable

Restricted access X
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2. Memory Read/Write by RDS

Section in the service manual:
4.2 Bit Switches
4.2.1 System Switches
System Switch 02 bits 6, 7

Wrong Description (shaded)

System Switch 02

No FUNCTION COMMENTS

 6

 7

Memory read/write by RDS
Bit 7    6      Setting
      0    0      Always disabled
      0    1      User selectable
      1    0      User selectable
      1    1      Always enabled

(0,0): All RDS systems are always locked out.
(0,1), (1,0): At any time, an RDS system can
access the machine.

(1,1): At any time, an RDS system can access
the machine.

Correct Description (shaded)

System Switch 02

No FUNCTION COMMENTS

 6

 7

Memory read/write by RDS
Bit 7    6      Setting
      0    0      Always disabled
      0    1      User selectable
      1    0      User selectable
      1    1      Always enabled

(0,0): All RDS systems are always locked out.
(0,1), (1,0): Normally, RDS systems are locked
out, but the user can temporarily switch RDS on
to allow RDS operations to take place. RDS will
automatically be locked out again after a certain
time, which is stored in System Switch 03 (see
below). Note that if an RDS operation takes
place, RDS will not switch off until this time limit
has expired.

(1,1): At any time, an RDS system can access
the machine.

Ricoh Technical Services
Aleady dealt with in the service manual
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RTB Update

FAX2900L firmware modification history

H5477200L
File: H5477200L.bin
Soft version: 53
ROM size: 2MB (16Mbit)
First address for downloading data to IC card: 200000
For RDS: H5477200L.lz / H5477200L.frh
Check-sum: SUM TOTAL= 1879, BOOT=53E9, MAIN=C490
PCB-FCU: H5476101R, H5476111S
Schedule: March 2001 (only for spare parts)

Reasons for change:
1) Software bug correction

- Scanning stops and the line is disconnected in ISDN G3 Tx mode (reported by REBV)
This does not occur when the memory card is installed.

2) Wording correction (Dutch)
- The name of SW usr 03 bits 3 and 4 has been corrected for the user parameter list.
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RTB Update

<FAX2900L firmware modification history>

<H5477200M>
File: H5477200M.bin
Soft version: 54
ROM size: 2MB(16Mbit)
First address for downloading data to IC card: 200000
For RDS: H5477200L.lz / H5477200L.frh
Check-sum: SUM TOTAL= 26B1, BOOT=53E9, MAIN=D2C8
PCB-FCU: H5476101S, H5476111T
Schedule: March 2001 (only for the spare parts)

Reason for change:

The stored memory reset problem has only been reported on Model S-4. However, the same modification

was applied to the S-3 because it was estimated that there was a possibility for it to occur on this model as

well.

Reference:
Procedure for downloading to the IC card:

1) Download the above file to the PC with the Swap File Utility.

2) Insert the IC card into the IC card slot.

3) Run the Swap File Utility.

4) Select Open from the File pull-down menu and then select the file.

5) Select Write from the Image pull-down menu and input the following items:

          Start Address: 200000.

          Length: (do not change).

          Check: card erase before write.

          Select: Hex.

6) Click "OK".

7) Print out the System Parameter List and confirm that the new ROM version is listed on the sheet.

RC REBV ASIA

∗ ∗ ∗
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